
 

WORKING WELL  
Planning a wellness initiative takes a lot of effort.  The good news is that you do not have to start from 
scratch when it comes to determining a program to use for your initiative.  
 
Using Evidence-Based Programs 
There are already several evidence-based programs 
available for you to implement.  Evidence-based programs 
are programs which research has shown to produce 
consistently good outcomes.  Therefore, using an 
evidence-based program within your initiative can add 
credibility to your project. 
 
SAMHSA Model Programs are evidence-based programs 
that have been screened and tested in communities, 
schools, social service organizations and workplaces across the nation.  These programs have provided 
solid proof that they have prevented or reduced substance abuse and other related high-risk behaviors.  
SAMHSA Model Programs have also been reviewed by SAMHSA's National Registry of Effective 
Programs (NREP).  To learn more about these programs, visit:  http://modelprograms.samhsa.gov. 
 
The Small Business Wellness Initiative delivered two evidence-based programs to small business 
workplaces.  The following SAMHSA model programs were adapted to fit the needs of the project: 
 
• Team Awareness, an 8-hour team building/social health program developed at Texas Christian 

University that interweaves communication skills, peer referral and stress management, was modified 
to a 4-hour program called Team Awareness Small Business.  This program was modified to a 4-hour 
training to meet the needs of the small businesses.  For more information on Team Awareness, visit 
www.organizationalwellness.com. 
 

• Healthy Workplace, a multi-component health promotion approach developed by ISA Associates, was 
modified to Choices in Health Promotion, a customized program based on a needs assessment with 
the small business operator.  Choices in Health Promotion modules included various topics, including 
Active Lifestyle; Healthy Eating; Alcohol, Drugs & Health; and Managing Stress.  For more 
information on Healthy Workplace, visit www.centerforworkforcehealth.com. 

 
There are many factors to consider when selecting an appropriate program for your initiative, including: 

• Does the program address the risk and protective factors identified as a priority? 
• Would our community be comfortable with the specified intervention components? 

 
Prevention professionals have recognized the necessity to be culturally competent in implementing 
programs.  Awareness of, and attention to, cultural issues in the planning and implementation stages 
should be considered. 
 
Both of the Small Business Wellness Initiative programs were adapted to be culturally appropriate by 
using information collected in an initial needs assessment with the small business manager.  For more 
information about the adapted programs, visit us at:  www.sbwi.org. 
 



 

WORKING WELL 
The Small Business Wellness Initiative adapted two evidence-based programs to meet the specific needs 
of the project. 
 
Working Programs 
If you haven’t already previewed and downloaded the programs utilized in the Small Business Wellness 
Initiative project, you can do so by visiting us at:  www.sbwi.org.  The programs are available for use, 
free of charge.  Each program includes a PowerPoint presentation and handouts. 
 
Team Awareness Small Business  
Team Awareness Small Business is a team-based training program, modified from the 
original Team Awareness model program, developed by Dr. Joel Bennett and colleagues 
at Texas Christian University.  The training was designed specifically to increase the 
awareness of behavioral health as a group concern rather than an individual burden. 
 

Choices in Health Promotion 
Choices in Health Promotion, adapted from the Healthy Workplace model program 
developed by ISA Associates, is a customized health promotion program based on a 
needs assessment with the small business operator or manager.  The Choices in Health 
Promotion program used a combination of modules including the following:  Active 
Lifestyle; Alcohol, Drugs and Health; Healthy Eating; Family Connection; Managing 
Stress; Safety & Moderation; Team Awareness modules; and Time and Presence. 

 
Active 

Lifestyle 

• Motivate participants to adapt or enhance an active lifestyle 
• Identify steps to incorporate physical activity into daily routine 
• Demonstrate different types of exercise activities 

Alcohol, Drugs 
& Health 

• Increase knowledge of alcohol and its effects 
• Increase or reinforce awareness about alcohol and dangers of abuse 
• Encourage self-reflection of personal level of alcohol use and potential risks 

Healthy 
Eating 

• Motivate participants to adopt or enhance healthy eating habits 
• Provide information on elements of a healthy diet 
• Identify factors associated with calorie and fat intake 

Family 
Connection 

• Engage participants at an emotional level 
• Demonstrate how to talk to children about alcohol and drugs 
• Help participants develop better parenting skills 

Managing 
Stress 

• Raise awareness of the impact that stress places on health and productivity 
• Encourage awareness of healthy options for dealing with stress 
• Improve or enhance stress coping skills 

Safety & 
Moderation 

• Heighten awareness of workplace safety concerns  
• Increase awareness of the relationship between stress and safety 
• Encourage focus on solution to safety issues 

Team Awareness 
Small Business* 

• Improve team building and communication skills 
• Decrease tolerance and enabling of problem behaviors 
• Identify ways to enhance team health and reduce risks 
*Denotes a four-hour training program 

Time & 
Presence 

• Heighten awareness of the problem of time compression 
• Encourage presence and spiritual health as a solution 
• Help understand the value of time/intimacy in life 

Tobacco 
Use 

• Provide general education on tobacco risks 
• Motivate participants to reduce or eliminate tobacco use 
• Provide an introduction to three tools relevant for tobacco cessation 

 



 

WORKING WELL 
Careful planning and preparation can help ensure the successful implementation of your wellness 
initiative and program.  Planning and preparation can also lead to better outcomes. 
 
Gearing Up for Wellness 
Once you have recruited a business to participate in your initiative, it is ideal to set 
up an initial meeting with the individual who will help coordinate the program at 
the participating business.  This meeting helps build rapport with the business and 
provides your training staff with a logistics overview.  There are several important 
topics to address at the initial meeting, including the following: 
 

• Needs Assessment-The needs assessment is designed to assist in customizing a unique program 
that reflects the participating business’ needs.  By completing a needs assessment with an 
organization, you will gain information that will help determine needs and options to create a 
program suitable to the business.  Be sure to record demographic information and special needs. 

 
• Scheduling-It is important to address scheduling at the initial meeting with a participating 

business.  Keep in mind that you will need to be flexible to accommodate multiple work groups 
and various work shifts.  Bring along a calendar with possible program dates. 

 
• Facilities-It can be very useful to visit the facility where the program will be delivered.  The 

program should take place in an area that is conducive to learning—where there is enough room, 
comfortable temperature, convenient location, etc.  Another important factor to consider when 
selecting a program location is equipment.  Try to visit the facility and determine your equipment 
needs prior to the program delivery date. 

 
• Workplace Tour-If allowed, it can be helpful to tour the workplace where you will deliver the 

program.  A tour often offers insight into the workplace culture and nature of the business.  This 
will help the trainer get a better understanding of some of the workplace issues that may arise.  In 
addition, a tour guide often provides additional information about the history of the organization. 

 
• Policies and Procedures-If possible, obtain copies of policies and procedures relevant to the 

program.  Some businesses may be reluctant to offer these documents, but you can reassure them 
that they will only be used to customize and incorporate organizational policies and procedures 
into the program materials. 

 
• Employee Participation-You should find out at the initial meeting how the participating business 

plans to promote the program to employees.  Some businesses may mandate the program or 
incorporate the program into its regular training schedule for employees.  Offer additional ideas 
for promoting participation among employees, including posting promotional flyers in employee 
break rooms and in employee pay stub envelopes. 

 
• Confidentiality-It is vital that participating employers and employees know that all information 

and policies collected from them during the course of the initiative will be kept confidential.  Be 
sure to cover your confidentiality policy with all participating employers.  This will help staff and 
employees to be more open when sharing information. 

 
If the above information is not obtained in the initial meeting with the participating business, it is 
imperative to obtain the information through follow-up meetings or conversations.  After you have the 
necessary information, you can begin planning and preparing for program delivery. 



 

 WORKING WELL 
There are a number of wellness tools available for you to use to implement your wellness initiative.  The 
tools discussed in this section are available from the Small Business Wellness Initiative. 
 
Using Wellness Tools 
Needs Assessment 
Once a needs assessment is conducted with a participating 
business, the data should be analyzed and shared with the 
trainer conducting the program.  The needs assessment 
provides valuable information needed to customize a 
program for a participating business.  The Small Business 
Wellness Initiative developed a needs assessment for the 
small business operator.  For more information, visit us at:  
www.sbwi.org. 
 
Customization 
In addition to downloading and using the Small Business Wellness Initiative program, you may customize 
or adapt these programs to meet the needs of your initiative.  Several of the programs used in the project 
were customized to meet the specific needs of a participating business.  For examples of customization, 
view the initiative’s research report available on our web site at:  www.sbwi.org. 
 
In some cases, the initiative included supplementary slides to existing programs to highlight employee 
assistance programs and emphasize workplace policies.  We also recognize that organizations may want 
to customize the program to reflect their own initiative.  There are a few ways to customize and/or 
incorporate the existing programs into your initiative: 
 
To modify the slide master or title master in the PowerPoint program: 

1. Select one of the slides associated with the master you want to change. 
2. Do one or both of the following:  

On the View menu, point to Master, and then click Slide Master.  
On the View menu, point to Master, and then click Title Master. 

3. Make the changes you want. For example, change the font type, change the color or size of the 
text, change the bullet character, or add a picture or text box. Be sure you don't delete or add 
characters in the placeholder text. 

4. On the Master toolbar, click Close. 
 
To create and include a new slide in the PowerPoint program: 

1. On the Insert menu, click New Slide. 
2. Scroll through the layouts, click the one you want, and then click OK. 

 
Additional Resources 
At the back of this manual, you will find contact information for the Small Business Wellness Initiative 
partners.  The collaborating partners offer additional resources, including technical assistance and train-
the-trainer workshops, to assist you in implementing your wellness initiative.  For more information about 
our resources and services, please visit us at: www.sbwi.org. 
 



 

WORKING WELL 
One difficult challenge in implementing an effective evidence-based program is finding the right balance 
between maintaining program fidelity and promoting adaptation of the program to reflect the community 
where it is being implemented.   
 
Maintaining Program Fidelity 
Fidelity is the degree to which a program is implemented as the program developer intended.  While 
adaptation may be required for your specific project, it is worth noting that maintaining program fidelity 
is a key factor in ensuring consistent outcomes of your program.   
 
The Small Business Wellness Initiative developed a fidelity checklist for each program.  Along with the 
fidelity checklist, each presentation included a program outline, as well as handout and supply checklists. 
It is also essential to conduct a series of train-the-trainer sessions to adequately prepare and coach 
trainers in effective program delivery.  
 
Sample Fidelity Checklist 

Choices in Health Promotion 
Preparation Points for Trainers 

 
GENERAL OBJECTIVES 

 All materials (handouts, slideshow) are prepared and organized in sequence for easy access and so 
that participants are not distracted by any lack of organization 

 Material is presented in a well-paced and organized manner with adequate time for questions and 
answers 

 Trainer speaks clearly and well paced (not too fast or too slow); There are adequate pauses for 
participant questions 

 Trainer maintains balance between presentation of materials and facilitated interaction 
 Trainer self-disclosure is appropriate and facilitates interest among participants 
 Trainer shows grasp of general theory and customization process behind Choices in Health 

Promotion (makes reference to ideas that led to the development of Choices) 
 Trainer states objectives of overall training and each module 
 There is a flow within each module and from module to module 
 Trainer encourages participant involvement 
 Trainer presentation exhibits vitality and healthy manner 
 Trainer shows memory for previous participant comments and integrates into flow of the training 
 Trainer is sensitive to self-disclosures and maintains atmosphere of confidentiality 
 Trainer works with classroom distractions and easily reorients distracted participants 
 Trainer keeps atmosphere of team-work; preventing any one participant from dominating discussions 

 
 
Supply Checklist 
While the supplies needed for program delivery will vary from program to program, most programs will 
require the following: 

� Laptop 
� Projector 
� Screen 
� Pens 
� EAP or Supplementary Handouts 
� Training Evaluations 
� Flipcharts 

� Markers 
� Tape 
� Extension Cord 
� Power Strip 
� Easel 
� Incentives



 

WORKING WELL 
Just as some initiatives work better than others, some workplace wellness programs may be more 
successful than others.  As with any program, increasing awareness must occur before people can take 
action and maintain a change. 
 
Evaluating Net Worth 
You developed some goals and objectives in the first part 
of this manual.  While there are several ways to evaluate 
the success of a program, it is best to evaluate your success 
based upon your established goals and objectives.  In 
addition, you may also want to highlight some of your 
successes: 
 

• How many businesses participated in your 
initiative? 

• Were participants satisfied with the program? 
• Which aspects of the program were best received? 
• Did the program improve knowledge about 

wellness issues?  
• Did the program change behavior?  

 
The Small Business Wellness Initiative used an experimental design with pre, post and follow-up surveys 
to determine effectiveness of our programs.  For a full research report, visit 
www.sbwi.org/research/research.htm. 
 
For a variety of measurement tools and options in evaluating program effectiveness, visit our partner, 
Organizational Wellness & Learning Systems at:   www.organizationalwellness.com. 
 
 
 



 

WORKING WELL 
Wellness and prevention programs can sometimes be difficult to implement and often face many 
challenges.  It may be helpful to forecast what these challenges or barriers might be and generate possible 
solutions for dealing with them. 
 
Overcoming Obstacles 
Certain obstacles may arise when implementing a wellness 
initiative targeted at small businesses.  However, there are 
several things you can do to ensure successful implementation 
of your programs.  Some of those things include: 

• Having an infrastructure in place to effectively 
communicate and market the benefits of the initiative 
and its programs 

• Ensuring staff receive thorough orientation and 
training to learn and distinguish the primary 
components of the initiative 

• Establishing working relationships with community 
organizations and agencies to recruit businesses to 
participate and to direct participants in need of help 
outside of the initiative’s area of expertise 

• Having supportive relationships and promoting a team 
environment among collaborators and staff 

• Planning ahead to appropriate adequate costs and efforts to recruitment and retention activities 
• Having access to services and agencies that can provide assistance to workers in various areas of 

health and wellness 
 
Small businesses also pose a challenging market.  Things that should be considered when working with 
small businesses include: 

• Employers, especially at smaller firms, sometimes do not feel that they have the resources, staff 
or time to implement such programs 

• Small business employers sometimes believe they are immune to problems evident in larger 
corporations 

• Finding an internal champion within the small business can be essential to the successful 
recruitment of a small business 

• Internal miscommunication within the small business can sometimes be challenging 
• Finding the right mix between programs and scheduling may differ from one business to the next 
• Initiative staff must demonstrate ability to be flexible to accommodate small business needs and 

schedules 
• Various literacy levels of a small, but important, number of workers in some settings 
• Seasonal differences in receptivity to participate from small business owners 

 



 

WORKING WELL  
 

Congratulations! 
  
You have successfully completed the Wellness Pays replication manual.  In the last section, you 
should have covered: 
 

 Using evidence-based programs 
 Working programs 
 Gearing up for wellness 
 Using wellness tools 
 Maintaining fidelity 
 Evaluating net worth 
 Overcoming obstacles 

 
The Small Business Wellness Initiative would like to congratulate you on your efforts in 
implementing a wellness initiative.  We hope that by now you have evaluated and achieved your 
goals and objectives set forth in the first section.  We know that you have already laid a great 
foundation for your initiative.  We would love to hear about it.  As mentioned in previous 
sections, additional resources, including technical assistance and train-the-trainer workshops are 
available to organizations like yours.  Please feel free to contact us. 
 
 


